
Q.1 What should come in place of the question mark (?) in the given series?

901 900 897 892 885 ?
Ans 1. 873

2. 877

3. 875

4. 876

Q.2 DREAM is related to ZNAWI in a certain way based on the English alphabetical order. In
the same way, DANCE is related to ZWJYA. To which of the given options is DOUBT
related, following the same logic?

Ans 1. ZKQXP

2. ZKVXP

3. ZKPXP

4. ZKKXP

Q.3 A vendor bought lemons at 7 for ₹1. How many lemons must he sell for ₹1 to gain 40%?
Ans 1. 5

2. 6

3. 9

4. 7

Q.4 In March 2025, which wildlife sanctuary in Punjab was proposed to be developed into a
leopard safari to boost eco-tourism? 

Ans 1. Jhajjar-Bachauli Wildlife Sanctuary

2. Harike Wildlife Sanctuary

3. Abohar Wildlife Sanctuary

4. Bir Moti Bagh Wildlife Sanctuary 

Q.5 The marked price of a bookshelf is ₹3,100, which is 25% above the cost price. It is sold
at a discount of 12% on the marked price. Find the profit percentage.

Ans 1. 9%

2. 8%

3. 10%

4. 11%

Test Center Name iON Digital Zone iDZ Manimangalam
Test Date 06/06/2025
Test Time 9:00 AM - 10:30 AM
Subject RRB NTPC Graduate Level I
* Note
Correct Answer will carry 1 mark per Question.
Incorrect Answer will carry 1/3 Negative mark per Question.

1. Options shown in green color with a tick icon are correct.
2. Chosen option on the right of the question indicates the option selected by the candidate.

Section : RRB NTPC Graduate Level I

www.go
vtj

ob
sa

ler
t.i

n

www.govtjobsalert.in



Q.6 Refer to the following number and symbol series and answer the question that follows.
Counting to be done from left to right only. All numbers are single-digit numbers.

(Left) 3 * 9 & % 4 6 @ 9 # 1 * £ 5 8 $ 7 & 3 Ω (Right)

How many such symbols are there each of which is immediately preceded by a symbol
and also immediately followed by a number?

Ans 1. One

2. Four

3. Two

4. Three

Q.7 Which of the following is NOT one of the ten indicators used in calculating the
Multidimensional Poverty Index (MPI)?

Ans 1. Nutrition

2. Years of schooling

3. Access to electricity

4. Internet connectivity

Q.8 A, B, C, D, E and F live on six different floors of the same building. The lowermost floor
in the building is numbered 1, the floor above it, number 2 and so on till the topmost
floor is numbered 6.
F lives on an even numbered floor but not 6. The sum of floors on which D and F live is
7. B lives immediately above A. The sum of floors on which F and C live is 3.
How many people live between B and F?

Ans 1. Two

2. Four

3. One

4. Three

Q.9 Which of the following statements is NOT correct with reference to the p-block
elements?

Ans 1. They belong to Groups 13 to 18.

2. They are also called transition elements.

3. Their outermost configuration varies from ns²np¹ to ns²np⁶.

4. They include non-metals and noble gases.

Q.10 Which of the following statements about Exercise CYCLONE, conducted in February
2025 is/are correct?

1. It was held at Mahajan Field Firing Ranges in Rajasthan.
2. The participating countries were India and Egypt.
3. The exercise focussed on artillery training of joint forces.

Ans 1. Only 1 and 2

2. 1, 2 and 3

3. Only 1

4. Only 2

Q.11 What was the main reason for the protest against the Simon Commission in 1928?
Ans 1. High taxes

2. Discrimination against minorities

3. Lack of Indian representation

4. Introduction of new laws
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Q.12 The average of 10 observations is 40. It was realised later that an observation was
misread as 33 in place of 50. Find the correct average.

Ans 1. 42.7

2. 41.7

3. 44.7

4. 40.7

Q.13 If Vishal covers 184 km in a boat in 48 hours against the stream and he takes 12 hours
with the stream, then find the speed of the stream.

Ans 1. 5.75 km/hr

2. 14.36 km/hr

3. 10.64 km/hr

4. 13.66 km/hr

Q.14 In a certain code language, ‘MUTE’ is coded as ‘3517’ and ‘EARS’ is coded as ‘2458’.
What is the code for ‘E’ in the given code language?

Ans 1. 5

2. 8

3. 2

4. 7

Q.15 If 1 is added to each odd digit and 2 is subtracted from each even digit in the number
1437586, what will be difference between the highest and lowest digits in the number
thus formed?

Ans 1. 6

2. 7

3. 4

4. 1

Q.16 The India-Bhutan boundary is primarily defined by which of these?
Ans 1. Desert

2. Border fencing

3. Mountains and treaties

4. Trade posts

Q.17 Find the volume (in cm3) of the largest right circular cone that can be cut out from a
cube with an edge of 8 cm.

Ans
1. 

2. 

3. 

4. 
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Q.18 Select the number from among the given options that can replace the question mark (?)
in the following series.
215 187 161 137 115 95 ?

Ans 1. 81

2. 87

3. 75

4. 77

Q.19 What happens to the particles of a substance when it is heated?
Ans 1. They move faster

2. They move slower

3. They stop moving

4. They disappear

Q.20 One pipe can fill the tank in 21 minutes while another pipe can empty completely filled
tank in 24 minutes. If both the pipes are operated together on empty tank, how long (in
minutes) will it take to fill one-fourth of the tank?

Ans 1. 84

2. 126

3. 168

4. 42

Q.21 NITI Aayog released the inaugural Fiscal Health Index (FHI) 2025. Which state topped
the index with the highest overall score, indicating strong fiscal management? 

Ans 1. Odisha

2. Maharashtra

3. Tamil Nadu

4. Karnataka

Q.22 In Gond painting, what is the traditional name given to the handmade brush used by
artists locally?

Ans 1. Kalam

2. Likhani

3. Kaadi

4. Koochi

Q.23 What is the average of the first 10 prime numbers?
Ans 1. 15.8

2. 16

3. 14

4. 12.9

Q.24 X, Y and Z invest a sum in the ratio 6 : 59 : 41 respectively. If they earned total profit of
₹3,180 at the end of year, then what is the difference between the share of Y and Z?

Ans 1. ₹540

2. ₹634

3. ₹432

4. ₹484
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Q.25 Find the simple interest (in ₹) if a sum of ₹350 is borrowed for 1.5 years at 20% per
annum rate of interest.

Ans 1. 155

2. 205

3. 85

4. 105

Q.26 Which of the following is the correct way to start a new blank presentation in MS
PowerPoint?

Ans 1. Press Ctrl + N

2. Press Ctrl + O

3. Click Insert → New Slide

4. Click File → Open

Q.27 What is the primary purpose of the American Standard Code for Information
Interchange (ASCII)?

Ans 1. To define a standardised set of codes for representing text and control characters

2. To enable secure encryption of data for internet transmission

3. To create a programming language for text-based applications

4. To design a graphical user interface for operating systems

Q.28 Evan starts from point A and drives 12 km towards west. He then takes a left turn, drives
6 km, turns left and drives 4 km. He then takes a right turn and drives 2 km. He then
takes a right turn and drive 3 km. He then takes a left turn and drives 3 km. He takes a
final left turn, drives 11 km and stops at point P. How far (shortest distance) and towards
which direction should he drive in order to reach point A again (all turns are 90° turns
only unless specified)?

Ans 1. 12 km north

2. 9 km south

3. 11 km north

4. 11 km south

Q.29 Seven boxes, A, B, C, D, E, F and G, are kept one over the other but not necessarily in
the same order. Only four boxes are kept between D and F. Only A is kept above D. Only
two boxes are kept between C and G. E is kept immediately above B. G is not kept
immediately above E. How many boxes are kept below E?

Ans 1. 4

2. 1

3. 3

4. 2

Q.30 In a certain code language,

A + B means ‘A is the mother of B’
A – B means ‘A is the brother of B’
A × B means ‘A is the wife of B’ and
A ÷ B means ‘A is the father of B’.

How is M related to Q if ‘M + N ÷ O × P – Q’?
Ans 1.  Brother's wife's mother's mother

2. Brother's wife's father's mother

3. Brother's wife's mother's sister

4. Brother's wife's father's sister
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Q.31 Based on the English alphabetical order, three of the following four letter-cluster pairs
are alike in a certain way and thus form a group. Which letter-cluster pair DOES NOT
belong to that group?
(Note: The odd one out is not based on the number of consonants/vowels or their
position in the letter-cluster.)

Ans 1. IJ - EF

2. OP - KL

3. MN - IJ

4. LD - KH

Q.32 Shyam starts from point A and drives 11 km towards the east. He then takes a right turn,
drives 5 km, turns right and drives 12 km. He then takes a right turn and drives 10 km.
He takes a final right turn, drives 1 km and stops at point P. How far (shortest distance)
and towards which direction should he drive in order to reach point A again? (All turns
are 90 degree turns only unless specified.)

Ans 1. 5 km to the north

2. 4 km to the north

3. 4 km to the south

4. 5 km to the south

Q.33 Which of the following letter-clusters should replace # and % so that the pattern and
relationship followed between the letter-cluster pair on the left side of :: is the same as
that on the right side of ::?

# : MLD :: VAM : %
Ans 1. # = SVJ, % = YFP

2. # = PQG, % = SVJ

3. # = YFP, % = BKS

4. # = BKS, % = PQG

Q.34 Which command in Windows 10 CMD will delete all .log files in the current directory
without asking for confirmation?

Ans 1. erase *.log

2. del *.log

3. del *.log /q

4. del *.log /p

Q.35 Which of the following soils has the highest water-retaining capacity?
Ans 1. Alluvial soil

2. Desert soil

3. Black soil

4. Red soil

Q.36 Which factor plays the most dominant role in the seasonal reversal of wind direction in
India?

Ans 1. Ocean currents

2. Latitude

3. Relief

4. Monsoonal pressure system

Q.37 During which dynasty did the Mongols, led by Qultlug Khwaja, besiege Delhi and inflict
significant damage?

Ans 1. Suri Dynasty
2. Mughal Dynasty
3. Khalji Dynasty
4. Sayyid Dynasty
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Q.38 Based on the English alphabetical order, three of the following four letter-clusters are
alike in a certain way and thus form a group. Which letter-cluster DOES NOT belong to
that group? (Note: The odd one out is not based on the number of consonants/vowels
or their position in the letter-cluster.)

Ans 1. SUP

2. PRV

3. NPK

4. GID

Q.39 How many new greenfield expressways are targeted for construction in India by the
financial year 2024-25?

Ans 1. 15

2. 10

3. 30

4. 22

Q.40

Ans 1. 14°

2. 10°

3. 7°

4. 4°

Q.41 Which one is NOT the method to search for and replace text in Microsoft Word?
Ans 1. Press Ctrl + H to open the Find and Replace window

2. Click on Alt + Enter key

3. Click 'Edit' and then select 'Find and Replace'.

4. Go to the 'Home' tab and select 'Replace'.

Q.42 Below are given two sets of numbers. In each set of numbers, a certain mathematical
operation on the first number results in the second number. Similarly, a certain
mathematical operation on the second number results in the third number and so on.
Which of the given options follows the same set of operations as in the question?
(NOTE – A two/three-digit number cannot be broken into individual digits for operations,
e.g. if 37 is followed by 10, the operation cannot be 3+7 as a two-digit number cannot be
broken into individual digits.)
11 - 12 - 13 - 26 ; 19 - 20 - 21 - 42

Ans 1. 7 - 8 - 9 - 18

2. 3 - 4 - 5 - 12

3. 4 - 5 - 6 - 10

4. 9 - 10 - 11 - 24

Q.43 What is India’s renewable energy target by the year 2030 in terms of installed capacity?
Ans 1. 500 GW

2. 100 GW

3. 175 GW

4. 300 GW

Q.44 If 68 is the mean proportion between x and 272, what is the value of x?
Ans 1. 15

2. 17

3. 19

4. 16
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Q.45 Which of the following characters is NOT allowed in a filename when renaming in
Windows?

Ans 1. - (hyphen)

2. # (hash)

3. _ (underscore)

4. ? (question mark)

Q.46 The mode and median of a dataset is 52.7 and 65, respectively. What is the mean of the
dataset? (Use empirical formula, and round off your answer to one decimal place.)

Ans 1. 62.5

2. 77.8

3. 71.2

4. 68.2

Q.47 Kanishka, the Kushana ruler, was a patron of which religion?
Ans 1. Zoroastrianism

2. Jainism

3. Christianity

4. Buddhism

Q.48

Ans 1. 420

2. 414

3. 259

4. 76

Q.49 Akshay spends 40% of his income. If he saves ₹24,000, then his income (in ₹) is:
Ans 1. 9,600

2. 40,000

3. 39,000

4. 41,000

Q.50

Ans 1. 121

2. 65

3. 133

4. 79

Q.51 If the selling price of a bed is 2-times of initial, then the profit is 11-times of initial. Find
the initial profit percentage.

Ans 1. 

2. 

3. 

4. 
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Q.52 If 24 is subtracted from three times an unknown number, the difference is 258. What is
the unknown number?

Ans 1. 94

2. 70

3. 78

4. 82

Q.53 In December 2024, Indian Navy Day was celebrated with which theme?
Ans 1. Guardians of the Sea with Strategic Operational Excellence

2. Strength and Power through Innovation and Indigenization

3. Blue Waters and Technological Strength for National Defence

4. Innovation and Self-Reliance for Maritime Supremacy in India

Q.54 In a certain code language, ‘joy lab poet’ is coded as ‘to dl dh’ and ‘poet win union’ is
coded as ‘dl fo kb’. How is ‘poet’ coded in the given language?

Ans 1. dl

2. to

3. dh

4. fo

Q.55 Sachin’s salary was first reduced by 16% and subsequently raised by 10%. What
percentage was his final salary lower compared to his initial salary?

Ans 1. 1.6%

2. 7.6%

3. 16%

4. 10%

Q.56 Article 31B was introduced to protect which type of laws from court challenges?
Ans 1. Land reform laws

2. Taxation laws

3. Environmental laws

4. Language laws

Q.57 Read the given statements and conclusions carefully. Assuming that the information
given in the statements is true, even if it appears to be at variance with commonly
known facts, decide which of the given conclusion(s) logically follow(s) from the
statements.

Statements:
Some deers are lions.
Some frogs are deers.
Some horses are lions.

Conclusions:
(I) Atleast some lions are frogs.
(II) Some deers are horses.

Ans 1. Only conclusion (II) follows.

2. Only conclusion (I) follows.

3. Neither conclusion (I) nor (II) follows.

4. Both conclusions (I) and (II) follow.

www.go
vtj

ob
sa

ler
t.i

n

www.govtjobsalert.in



Q.58
.

Ans
1. 

2. 

3. 

4. 

Q.59 What type of coastal plain are the Western Coastal Plains of India classified as?
Ans 1. Emergent coastal plain

2. Deltaic coastal plain

3. Submerged coastal plain

4. Tidal coastal plain

Q.60 According to luxury resort developer Fine Acers 2025, the market for branded
residences and resorts in India is expected to reach ₹8,610 crore (US$ 1 billion) by .

Ans 1. 2029

2. 2028

3. 2026

4. 2027

Q.61 Each of M, N, O, P, Q, R and S has an exam on a different day of the week, starting from
Monday and ending on Sunday of the same week. S has an exam on Friday. Only two
people have exams between S and R. O has an exam immediately before N. M has an
exam immediately after P. S has an exam on one of the days after M. On which day does
Q have an exam?

Ans 1. Sunday

2. Wednesday

3. Friday

4. Monday

Q.62 WJ 15 is related to UN 11 in a certain way. In the same way, QH 8 is related to OL 4. To
which of the given options is RI 3 related, following the same logic?

Ans 1. PM −1

2. TR −5

3. PL −7

4. IN −9

Q.63 What happens when an Indian citizen renounces their citizenship?
Ans 1. They lose their Indian citizenship.

2. They become a foreign diplomat.

3. Nothing changes.

4. They are fined.
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Q.64 What should come in place of the question mark (?) in the given series based on the
English alphabetical order?

NKR PMT ROV TQX ?
Ans 1. VRZ

2. VSY

3. VSZ

4. VRY

Q.65 The difference between the compound interest, compounded annually and the simple
interest if ₹17,700 is deposited at 4% rate of interest per annum for 2 years is:

Ans 1. ₹18.12

2. ₹28.32

3. ₹33.42

4. ₹27.62

Q.66 Manoj has 200 litres of Oil A and 274 litres of Oil B. He fills a number of identical
containers with the two types of oil in a manner that each container has only one type
of oil, and all containers are completely filled. What can be the maximum volume (in
litres) of each container that Manoj uses, so that all the oil that Manoj has, of both the
types, can be poured into these containers?

Ans 1. 3

2. 10

3. 2

4. 8

Q.67 Which country hosted the 78th Cannes Film Festival in May 2025?
Ans 1. Spain

2. The Netherlands

3. Germany

4. France

Q.68 What type of assistance is being provided by India to Myanmar under Operation
Brahma 2025?

Ans 1. Only medical assistance

2. Disaster relief material, humanitarian assistance, search & rescue teams

3. Only food supplies

4. Only financial assistance

Q.69 Refer to the following number and symbol series and answer the question that follows.
Counting to be done from left to right only. All numbers are single-digit numbers.

(Left) 4 6 & 8 $ 7 & 3 9 # % 4 6 @ £ 5 Ω 9 # 1 * 7 (Right)

How many such symbols are there each of which is immediately preceded by a number
and also immediately followed by another number?

Ans 1. Four

2. Three

3. Six

4. Five

www.go
vtj

ob
sa

ler
t.i

n

www.govtjobsalert.in



Q.70 According to the Economic Survey 2025, what was the unemployment rate in India for
2023-24?

Ans 1. 4.5%

2. 6.5%

3. 5.2%

4. 3.2%

Q.71
Ans

1. 

2. 

3. 

4. 

Q.72 Who were the winners of the Balbir Singh Sr Award for Player of the Year 2025 in the
men’s and women’s categories?

Ans 1. Harmanpreet Singh and Vandana Katariya

2. Manpreet Singh and Rani Rampal

3. PR Sreejesh and Navjot Kaur

4. Harmanpreet Singh and Savita Punia

Q.73

Ans 1. 21.5

2. 15.5

3. 8.6

4. 11.5

Q.74 What will come in place of the question mark (?) in the following equation, if ‘+’ and ‘−‘
are interchanged and ‘×’ and ‘÷’ are interchanged?

66 ÷ 8 − 231 × 11 + 14 = ?
Ans 1. 515

2. 545

3. 535

4. 525

Q.75 Which of the following actors was honoured with the 2025 International Goya Award for
his contributions to global cinema?

Ans 1. Cate Blanchett

2. Sigourney Weaver

3. Juliette Binoche

4. Richard Gere
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Q.76 Each of the digits in the number 8142769 is arranged in the ascending order from left to
right. Which of the following digits will be fourth from the left in the new number thus
formed?

Ans 1. 6

2. 2

3. 8

4. 4

Q.77 What milestone did Virat Kohli achieve in the 2025 IPL season (as of 15 April, 2025)?
Ans 1. Registering a combined total of 1000 fours and sixes in IPL history

2. Winning 5 IPL titles

3. Hitting 500 sixes in the IPL

4. Scoring 10,000 runs in the IPL

Q.78 Simplify: 127 - [7 x (1 - 5 + 4)] ÷ 91
Ans 1. 127

2. 135

3. 118

4. 133

Q.79 Who among the following is NOT considered a leader of the Moderates in the Indian
National Congress?

Ans 1. Aurobindo Ghosh

2. Ferozshah Mehta

3. Gopal Krishna Gokhale

4. Dadabhai Naoroji

Q.80 When x is added to each of 22, 26, 19 and 21, then the numbers so obtained, in this
order, are in proportion. Then, if 2x : y :: y : (4x-8), and y > 0, what is the value of y?

Ans 1. 54

2. 48

3. 37

4. 46

Q.81 Refer to the following number and symbol series and answer the question that follows.
Counting to be done from left to right only. All numbers are single-digit numbers.

(Left) 6 @ 8 £ 5 @ $ 7 & 3 6 & # 9 # 1 * £ 5 (Right)

How many such numbers are there each of which is immediately preceded by a symbol
and also immediately followed by another number?

Ans 1. Three

2. One

3. Two

4. Four

Q.82 A patient lacking bile production would suffer from deficiency in absorption of ______.
Ans 1. glucose

2. water

3. fat-soluble vitamins

4. amino acids
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Q.83 The 2025 World Economic Forum introduced which initiative focusing on India's role in
global geopolitics and innovation?

Ans 1. India Rising

2. Bharat 2030

3. Global India Dialogues

4. Indo-Pacific Forum

Q.84 What happens if a law is declared unconstitutional under judicial review?
Ans 1. It becomes null and void.

2. It is amended by the President.

3. It remains valid but unenforceable.

4. It is sent back to the Parliament for reconsideration.

Q.85 A and B can do a job in 25 days and 18 days, respectively. A works alone for 4 days and
leaves. The number of days required by B to complete the remaining job is:

Ans
1. 

2. 

3. 

4. 

Q.86 When was the protection and improvement of environment and safeguarding of forests
and wildlife as a directive added in the Constitution of India?

Ans 1. 1976

2. 2002

3. 1978

4. 2011

Q.87 When were privy purses officially abolished in India?
Ans 1. 1980

2. 1956

3. 1971

4. 1969

Q.88 The Desert National Park is renowned for which endangered bird species?
Ans 1. Great Indian Bustard

2. Peacock

3. Great Hornbill

4. Bengal Florican

Q.89 What will come in place of the question mark (?) in the following equation, if ‘+’ and ‘–’
are interchanged, and ‘×’ and ‘÷’ are interchanged?

56 – 12 × 4 ÷ 9 + 5 = ?
Ans 1. 78

2. 90

3. 54

4. 55
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Q.90 6893.5 × 603.3 × 0.3019 is equal in value to:
Ans 1. 6.8935 × 6.033 × 301.9

2. 689.35 × 603.3 × 301.9

3. 6.8935 × 60.33 × 30.19

4. 68.935 × 6033 × 3.019

Q.91 The arithmetic mean of the observations 28, 31, 40, 63, 57, 37, 34, 70 and 99 is:
Ans 1. 55

2. 50

3. 51

4. 41

Q.92 A, B, C, D, G, H, and I are sitting around a circular table facing the centre.
H sits to the immediate right of D. Only three people sit between H and I when counted
from the left of H. Only three people sit between D and C. A sits to the immediate right of
G. How many people sit between D and G when counted from the right of G?

Ans 1. One

2. Four

3. Three

4. Two

Q.93 A group of numbers/symbols is coded using letter codes as per the codes given below
and the conditions that follow. If none of the conditions apply, then codes for the
respective number/symbol to be followed directly as given in the table.
Number/S

ymbol
3 9 7 & 2 @ 5 % 1 8 ∆ 4 6

Code L C Z M D W A P R T F B K

Conditions:
(i) If the first element is a symbol and the last a number, the codes for these two (the
first and the last elements) are to be interchanged.
(ii) If the first element is an odd number and the last an even number, the first and last
elements are to be coded as ©.
(iii) If both the second and third elements are perfect squares, the third element is to be
coded as the code for the second element.

What will be the code for the following group?
@ 9 7 8 3

Ans 1. L C Z T W

2. T C B L W

3. W T C B L

4. L C T B W

Q.94 What powers were reinstated to the States by the 105th Constitutional Amendment Act?
Ans 1. Power to decide election dates

2. Power to levy GST

3. Power to form new states

4. Power to identify Socially and Educationally Backward Classes (SEBCs), including
Other Backward Classes (OBCs)

Q.95 P, Q, R, S, T, U and V are sitting around a circular table facing the centre. Only three
people sit between R and Q when counted from the left of R. Only three people sit
between V and U when counted from the right of U. S sits to the immediate right of V. T
is an immediate neighbour of U as well as Q. How many people sit between T and P
when counted from the right of P?

Ans 1. 1

2. 4

3. 2

4. 3
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Q.96 What should come in place of the question mark (?) in the given series based on the
English alphabetical order?

VQL TOJ RMH PKF ?
Ans 1. DNI

2. NID

3. NDI

4. DIN

Q.97 The sides (in cm) of a right triangle are (x − 13), (x − 26) and x. Its area (in cm2) is:
Ans 1. 1012

2. 1014

3. 1010

4. 999

Q.98 The sides of a rectangular field are 169 m and 154 m long. Its area is equal to the area of
a circular field. What is the circumference (in m) of the circular field?

Ans 1. 540

2. 525

3. 572

4. 544

Q.99 How many recognised styles of Vedic recitation (Pathas) are there?
Ans 1. Nine

2. Ten

3. Eleven

4. Seven

Q.10
0

RD 14 is related to UF 10 in a certain way. In the same way, CR 10 is related to FT 6. To
which of the given options is ON 1 related, following the same logic?

Ans 1. RP −3

2. RS −1

3. PR −9

4. QF −7
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